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Solid state equipment has operational characteristics differing from those of 
electromechanical equipment.  “Safety Guidelines for the Application, 
Installation and Maintenance of Solid State Controls” describes some important 
differences between solid state equipment and hard-wired electromechanical 
devices.  Because of this difference, and also because of the wide variety of uses 
for solid state equipment, all persons responsible for applying this equipment 
must satisfy themselves that each intended application of this equipment is 
acceptable. 

 
In no event will the Helm Instrument Company be responsible or liable for 
indirect or consequential damages resulting from the use or application of this 
equipment. 

 
The examples and diagrams in this manual are included solely for illustrative 
purposes.  Because of the many variables and requirements associated with any 
particular installation, the Helm Instrument Company cannot assume 
responsibility or liability for actual use based on the examples and diagrams. 

 
No patent liability is assumed by Helm Instrument Company with respect to use 
of information, circuits, equipment, or software described in this manual. 

 
Reproduction of the contents of this manual, in whole or in part, without written 
permission of the Helm Instrument Company is prohibited. 

 
Throughout this manual we use note to make you aware of safety 
considerations. 

 
 

ATTENTION: Identifies information about practices or 
circumstances that can lead to property damage. Identifies 
information that is especially important for successful 
application and understanding of the product. 

 
Attentions help you: 
 identify a hazard 
 avoid the hazard 
 recognize the consequences 
 

 
                                                                                                                                

ATTENTION: Please check power supply ratings before 
proceeding!  Each tonnage module consumes (+24, 173 mA  
+5, 220mA).  Be sure to not overload the power supply.            

 
 

Important User 
Information 
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Preface 
 

Read this preface to familiarize yourself with the rest of this manual.  This 
preface covers the following topics: 
 
 who should use this manual 
 the purpose of this manual 
 terms and abbreviations 
 conventions used in this manual 

 
 
 

Who Should Use this Manual 
 

Use this manual if you are responsible for the design, installation, 
programming, or maintenance of an automation control system. 
 
You should have a basic understanding of a Profibus DP network.  You 
should understand electronic process control and be able to interpret the 
ladder logic instructions required to generate the electronic signals that 
control your application. 

 
 

Purpose of This Manual 
 

This manual is a learning and reference guide for the Helm HM-2-SSI 
Module.  It contains the information you need to install, wire, and use the 
module. 
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Contents of this Manual 

Chapter Title Content 

 Preface 

Describes the purpose, background, and 
scope of this manual.  Also specifies the 
audience for whom this manual is intended 
and defines key terms and abbreviations 
used throughout this book. 

1 Overview 
Provides a hardware and system overview.  
Explains and illustrates the components of 
the system. 

2 Installation and Wiring Provides installation information and wiring 
guidelines. 

3 
Channel Configuration, 

Data and Status 

Examines the channel configuration and the 
channel status word, and explains how the 
module uses configuration data and 
generates status during operation. 

4 Initial Setup Procedures 

Gives setup instructions for initial setup.  
This includes the hardware setup, as well as 
installing the GSD file, and Siemen’s ladder 
logic. 

5 Troubleshooting 
Explains how to interpret and correct 
problems that occur while using the load 
module. 

A Specifications 
Provides physical, electrical, Environmental, 
and functional Specifications for the 
module. 

B Module Diagrams 

 
Included diagrams are the load module 
layout, Profibus wiring, strain gage wiring 
module I/O wiring, master/slave config. 
Wiring, and encoder wiring.  
 

C GSD File 

 
GSD files are used by Profibus 
configuration tools to enable a master 
Profibus scanner module - either in a PLC or 
PC - to know what slave devices are to be 
communicated to, their node address, what 
parameters can be read and written to and 
more. 
 

D Address Values Provides Image Blocks 

E Siemen’s Ladder Logic Provides Siemen’s Ladder Logic program 

Preface 
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 Terms and Abbreviations 
 
The following terms and abbreviations are used throughout this manual. 
 
Calibration - Procedure, performed by trained personnel, where machine or press is dynamically 
loaded to impact on load cells.  This is the process of linearity measuring to determine the 
loading capacity of the machine. 
 
Calibration Number - An amplification values established during machine calibration or pre-
assigned on force load cells. 
 
Channel - Refers to one of two, strain gage inputs available on the modules terminal block.   
 
Configuration Word - Contains the channel configuration information needed by the module to 
configure and operate each channel.  Information is written to the configuration word through the 
logic supplied in your ladder program. 
 
HM-2-SSI - Helm monitoring module; provides processor input from up to two sensors. 
 
Gain - Amplification of an input signal. 
 
Load/Force - Measurement of impact during a machine cycle.  Sensors provide the input for this 
measurement. 
 
Look Window - Resolver or cam activated window which allows specific degrees in a machine 
cycle to be processed. 
 
Low Alarm Inhibit - Number of consecutive machine cycles where low alarm is inhibited.  
Used in a process where machine cycles several times before running speed is established. 
 
LSB - (Least Significant Bit) Refers to a data increment defined as the full scale range divided 
by the resolution.  The LSB represents the smallest value within a string of bits. 
 
Monitor Parts Mode - Status condition used during production run.  Sample and compare logic 
is enabled.  On resolver based systems, tracking alarm limits can be enabled. 
 
Press Curve - Machine manufacturers provide this data table which defines limits on maximum 
load that should be exerted at a given degree of press stroke.  This data is stored in EEPROM 
memory in the Helm processing unit. 
 
Press Curve Alarm - Indication of resolver position and load when load at a given degree meets 
or exceeds press curve profile. 
 
 
 

Preface 
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Resolution - The smallest detectable change in a measurement, typically expressed in 
engineering units (e.g. 0.15C) or as a number of bits.  For example a 12-bit system has 4,096 
possible output states.  It can therefore measure 1 part in 4096. 
 
Resolver - Sometimes called encoder.  Device attached on a machine to determine stroke 
position.  Sine/cosine based resolver required for Helm systems. 
  
Reverse Load - Measurement of negative load/force being exerted on machine following the 
break-through of material, also referred to as snap through.  
 
Sample - Load/force values established from a series of machine cycles, also defined as 
benchmark. 
 
Sample Count - User input value used to specify how many machine cycles to base the sample 
on. 
 
Sampling time - The time required by the A/D converter to sample an input channel. 
 
Scale - Value used to describe the press/machine overall tonnage.  Set for maximum value of one 
channel.  For example, settings for a 150 ton press = 75. 
 
Setup Mode - Status condition of monitor typically enables during die setup.  Machine capacity 
alarms are enabled.  On resolver based systems, press curve alarm can be enabled.  This mode is 
also used during machine and resolver calibrations. 
 
Status Word - Contains status information about the channel’s current configuration and 
operational state.  You can use this information in your ladder program to determine whether the 
channel data word is valid. 
 
Target Load - A reference load established by the user.  Used primarily during setup to improve 
setup time. 
 
Tolerance /Trend Alarm - User defined upper and lower control limits established during the 
sample and compare process.  These limits are established on the peak load and will activate the 
machine stop relay when exceeded. 
 
Tracking Alarm - Requires resolver input. The sample and compare process is applied to the 
entire forming force based on user selected upper and lower control limits. 
 
Trend Deviation - Percent of change, high and low, from sample value to current value. 
 
TSM - Acronym for Through-the-Stroke load monitoring. Resolver input is required for 
monitoring the load being developed during machine cycle. 
 

Preface 
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Common Techniques Used in this Manual 
 

The following conventions are used throughout this manual: 
 

 Bulleted lists such as this one provide information, not procedural steps. 
 Numbered lists provide sequential steps or hierarchical information. 

 
 
 

Product Support 
 
Contact your Helm representative or call Helm direct at 419/893-4356: 
 

 sales and order support 
 product technical training 
 warranty support 
 support service agreements 

 
 
 

Your Questions or Comments on this Manual 
 
If you have any suggestions for how this manual could be made more useful to you, 
please send us your ideas. 

 

Preface 
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 Chapter 1 

 

Overview 
 

You have just purchased the most advanced strain monitoring solution 
available.  HELM INSTRUMENT COMPANY, INC. manufactures a 
complete line of strain monitoring control solutions for use on metal 
stamping, forging, compaction and assembly presses; cold forming, cold 
heating, injection molding and die cast machines. 
 
At HELM, quality is inherent not only in the design of our products but in 
the attitudes of our employees as well.  We’re working together to give 
you the best.  After all, that’s what our business is all about - providing 
innovative instrumentation to help make your manufacturing process more 
productive and your operation more effective. 
 
The Helm HM-2-SSI combines machine and tooling monitoring with 
programmable limit switch function.  User programmable high and low 
limits protect the machine and tooling to ensure part quality. 
 

 

Strain Gain Transducer Operation 
 
The primary part of the load monitoring system centers around the 
measurement.  The basic function of the Helm Strain Gain sensor is to 
detect the amount of deflection imposed on the press or die  as parts are 
being formed.  All Strain Gain sensors are matched to within 1% and 
therefore can be replaced without recalibration of the machine. 
 
The Helm Strain Gain sensors can be mounted to strategic high stress 
areas of the machine frame or strategically located in tooling or applied to 
stop blocks.  Signals from these sensors are routed to the HM-2-SSI 
module for processing.  The Helm Strain Gage is capable of measuring 
either a tension or compression signal. 
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HM-2-SSI Features 
 
 

 Two channel Strain Gage input with Auto Zero (350-700 ohm) 
  
 PROFIBUS DP slave 

 
 DIN rail mount 

 
 Peak models 

 
 Pre-programmed screens for Siemens HMI's 

 
 Applications include Stamping, Forging, Die Cast, Injection Molding, 

Assembly and Weigh Scale 

 

 

CHAPTER 1 
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Hardware Overview 
 
 

The force module uses Profibus communications.  It interfaces to strain 
gage based transducers (350ohm or 700ohm). 
 
The HM-2-SSI module receives and stores digitally converted analog data 
into its image table for retrieval on a Profibus network.  The module 
supports connections from two strain gage sensors. 
 

CHAPTER 1 
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Hardware Features 
 
 

 
 
 

METER/MESSAGE DISPLAY: 

 
- The message display shows menu settings, and calibration values. 
 

BALANCE ADJ. (CH. 1): 

 
- Used to set CH. 1’s amplifier to 0. 
 

GAIN ADJ. (CH. 1): 

 
- Used to adjust CH.1’s calibration number or gain value. 

CHAPTER 1 CHAPTER 1 
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RECORDER OUTPUT JACK: 

 
- The recorder output jack outputs the analog signals of CH. 1 and CH. 2. 
 

 
BALANCE ADJ. (CH. 2): 
 

- Used to set CH. 2’s amplifier to 0. 
 

GAIN ADJ. (CH. 2): 

 
- Used to adjust CH.2’s calibration number or gain value. 

 

PROFIBUS CABLE CONNECTION: 

 
- Profibus communication jack 
 

MODE STATUS LED’S: 

 
- Calibration LED 
 

o This LED is lit if the module’s calibration resistor is on. 
 

- AZ 
 

o This LED is lit when Auto-Zero (AZ) is turned on. 
 

- Status 
 

o Solid Green → Online Profibus Communications 
 
o Flashing Green → Offline Profibus Communications 

 
o Solid Red → ERROR: Profibus Communication Fault 
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UP/DOWN BUTTONS: 

 
- The up/down buttons are used to change settings and values. 
 

 

SELECT/ENTER BUTTON: 

 
- This button allows the user to navigate through the menu. 

 
 

MODE/STORE BUTTON: 

 
- This button turns Calibration Mode on and off. 
 
- When in other settings, this button is used to save the current values to the 

module’s EEPROM. 

CHAPTER 1 
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 Chapter 2 
 
 
 

Getting Started 
 

This chapter can help you to get started using the Helm HM-2-SSI module.  
The procedures included here assume that you have a basic understanding of 
Profibus communications.  You should understand electronic process control 
and be able to interpret the ladder logic instructions required to generate the 
electronic signals that control your application. 
 
Because it is a start-up guide, this chapter does not contain detailed 
explanations about the procedures listed.  It does, however, reference other 
chapters in this book where you can get more information about applying the 
procedures described in each step. 
  
If you have any questions or are unfamiliar with the terms used or concepts 
presented in the procedural steps, always read the referenced chapters and 
other recommended documentation before trying to apply the information. 

 
This chapter will: 

 

 tell you what equipment you need 

 explain how to install and wire the module 

 show you how to set channels for the sensor input 

 

Required Tools and Equipment 
 

Have the following tools and equipment ready: 
 

 small blade screwdriver 

 potentiometer trimmer (tweaker) 

 appropriate strain gage cable 

CHAPTER 2 
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System Operation 
 
The HM-2-SSI module communicates to a PLC through Profibus and 
receives+24Vdc power from an external power supply.  
 
Each individual channel on the module can receive input signals from strain 
gage based sensors.  The module converts the analog values directly into 
digital values. 

 
 

Sensor Wiring 
 

The module contains an 8-pin orange connector for wiring to the strain gages 
or load cells. The pin-out is shown below for both types used. 
 
 
 
 
 

 

CHAPTER 2 
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Chapter 3 
 

Channel Configuration Data and Status 
 

This chapter explains how the HM-2-SSI module communicates though the module’s 
input and output image using Profibus.  It lists the preliminary setup and operation 
required before the module can function. 

Output Image Block  (DB131 for Ch1,2     DB137 for Ch3,4) 
This data block is the image of the output of the module. You can control the behavior of 
the module from this area such as setting the tonnage alarm limit values, changing the 
module’s mode of operation, and etc.  

Block:DB
DB131 

Data 
Type Bit 

Description 

+0.0 
+0.1 
+0.0 
+1.0 
+1.1 
+1.2 
+1.3 

Bit 
Bit 
Bit 
Bit 
Bit 
Bit 
Bit 

0 
1 
2 
8 
9 
10 
11 

 
Alarm Reset 
 
Set Calibrate mode 
Set Setup mode 
Set Monitor Mode 

+2.0 INT - Look Window Start Degree  (in Calibrate mode only) 
+4.0 INT - Look Window Degree Step Value (1, 2, 4, 6, 8, 10,) (in Calibrate mode Only) 
+6.0 INT - Set Ch1 High Capacity Alarm Value (in Calibrate mode) 
+8.0 INT - Set Ch2 High Capacity Alarm Value (in Calibrate mode) 
+10.0 
+11.0 
+11.1 
+11.2 
+11.3 
+11.4 
+11.5 
+11.6 
+11.7 

- 
Bit 
Bit 
Bit 
Bit 
Bit 
Bit 
Bit 

- 
0 
1 
2 
3 
4 
5 
6 
7 

- 
Press Curve Alarm On/Off 
Tracking Alarm On/Off 
Trend Alarm On/Off 
Delta Track On/Off 
Alarm Value type   (1 = Tolerance in Ton,  0 =  Tolerance in Percent) 
AMPTRACK On/Off 
 
8000 DP On/Off 

+12.0 INT - Set Sample Count (2, 4, 8, or 16) 
+14.0 INT - Set Low Alarm Inhibit Count 
+16.0 INT - Alarm Start Degree Value (Tracking alarm only) 
+18.0 INT - Alarm Stop Degree Value (Tracking alarm only) 
+20.0 INT  Set Ch1 Low Tolerance value 
+22.0 INT - Set Ch1 High Tolerance value 
+24.0 INT  Set Ch2 Low Tolerance value 
+26.0 INT - Set Ch2 High Tolerance value 
+28.0 INT - Set Threshold for Tracking Alarm (In Percent) 
+30.0 INT - Press Curve Input Value  in 0 degree (in Calibrate mode) 
+32.0 INT - Press Curve Input Value in 10 degree (in Calibrate mode) 
+x.0 INT - Press Curve Input Data  in y degree (in Calibrate mode) 
+98.0 INT - Press Curve Input Value in 340 degree (in Calibrate mode) 
+100.0 INT - Press Curve Input Value in 350 degree (in Calibrate mode) 
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Alarm Reset Bit 
Set this bit On(1) for at least 50ms or longer to clear all present alarm condition of the module.  

 
Set Calibrate Mode Bit 
When set On (1), the module is in calibration mode.  No alarms are active.   
Note: all other mode bits must be off. 

 
Set Peak Mode Bit  
When set On (1), the module is in setup mode.  Capacity alarms are active. 
Note: all other mode bits must be off. 

 
Set Monitor Parts Mode Bit 
When set On (1), the module is in monitor parts (trend monitoring) mode. Capacity alarms and 
trend alarms, Tracking alarm are available. 
Note: all other mode bits must be off. 
 
Look Window Start Degree   
Enter a press crank angle where you want the module to start monitoring /capturing peak load 
and load signature. For module to take effect of new setting, the module must be in Calibrate 
mode.  
 
Look Window Degree Step Value (1, 2, 4, 6, 8, 10,)  
This is an increment value to determine the stop look window angle. Once the Step value is 
entered, the Stop look window angle is calculated internally. In order to determine actual Stop 
look window angle for your reference, use the following formula:    

 
Stop Look window Angle = Start Look Window Angle +  (224 * Step Value) * 0.1 
   

Set Ch1(2) High Capacity Alarm Value 
Integer value of high capacity alarm setting. Range = 0 to 9999.   A value of 0 disables alarm. 
The value entered will not be valid in the module until in Calibrate mode. 
HIGH CAPACITY is the limit for the maximum peak tonnage allowed to operate the machine. 
Normally the value is set at or below the scale value which is the capacity of the machine divided 
by the number of frame sensor channels. HIGH CAPACITY alarm is available in all modes. 

 
Function Switches 
 
AMPTRACK On/Off -  The AMPTRACK feature pertains to the filtering of tracking alarms, and 

helps to avoid “nuisance” type of alarms. The filtering occurs on the area where the load is 
constantly varies within the press stroke. AMPTRACK filtering can be seen in the wave 
screen, where constant variation area of the sample signature (along with the tracking 
bands) are filtered during relatively small portions of the stroke.  
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8000 DP On/Off Press -  This option is used for double action press machine with dual bridge 
sensor for differential load monitoring application. 

 
Curve Alarm On/Off – Press Curve alarms are valid in “setup” mode only, and provide press 

protection. Data points are retrieved from the press manufacture. These points represent 
tonnage limitations per angle of the press stroke. During the part process, if the tonnage 
exceeds the press curve limitation at any specific angle, a press curve alarm is triggered. 

 
Tracking Alarm On/Off - Track alarms, are valid in “monitor-parts” mode only, and are based off 

the “sample curve” taken during the “learn cycle”. Track alarms provide a thorough “parts 
quality” type of feature, because monitoring continues throughout the press stroke (based on 
the look window settings in the “Other Settings” screen).  

 
Trend Alarm On/Off - Trend alarms, are valid in “monitor-parts” mode only, and are base off the 

“sample peak” taken during the “learn cycle”. Trend alarms provide a “parts quality” type 
of feature, triggering alarms if the peak tonnage goes out of range of the tolerance. 

 
Delta Track On/Off - The delta track feature pertains to the filtering of tracking alarms, and helps 

to avoid “nuisance” type of alarms. The filtering occurs during sudden force change within 
the press stroke. Delta track filtering can be seen in the wave screen, where high slopes of 
the sample signature (along with the tracking bands) are filtered during relatively small 
portions of the stroke. 

 
Alarm Value type   (1 = Tolerance in Ton,  0 =  Tolerance in Percent) 

Tolerance alarms run in either tons or percent, which is selected in the jobs screen. At loads 
less than peak (throughout the stroke), tolerance in the percent mode is less than tons mode. 
This can be seen in the “wave” screen when comparing tons to percent. 

 
 
Set Sample Count 
Enter one of the numbers (2, 4, 8,or 16). This is the number of cycles for the module to take to 
learn new sample(Target) tonnage for Trend alarm feature. 

 
Set Low Alarm Inhibit Count 
Enter a number of cycles for module to inhibit low trend alarm when sampling is done in 
Monitor mode. To disable this feature, enter ’0’. 

 
Alarm Start/Stop Degree Value  
The user may choose to confine the track alarm “window” to avoid possible nuisance alarms. 
Start and Stop track angles must be within the look window.  

 
Set Ch1(2) High/Low Tolerance Value 
Integer values of high and low limit for trend alarm settings. Values are set in percent or in ton 
and represent the maximum and minimum percent/ton of change off the sample value.  Range  = 
0 to 99% or 0 to 255ton.  A value of 0 disables alarm. 
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Set Threshold for Tracking Alarm(in Percent) 
This is to ignore the tracking alarm from monitoring the area of the load signature below the set 
percentage of the current peak tonnage.  For example, if Tracking Low Inhibit is set to 10% and 
the current peak load is 90ton, then through out the load signature, tracking alarm will not 
monitor any tonnages below 9 ton. 
 
Press Curve Input Values ( 36 words) 
Enter 36 points of press Curve data for the press machine. These points represent tonnage 
limitations per angle of the press stroke. During the part process, if the tonnage exceeds the press 
curve limitation at any specific angle, a press curve alarm is triggered. 
The 36 points of data are generated from the press curve charts provided by the press 
manufacture. Please contact Helm Instrument to get more information how to obtain the Press 
Curve data points for your machine. 
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Input Image Block (DB130 for Ch1,2 DB 136 for CH3,4) 
This data block is an image of the Input of the module. You can monitor the status of the 
module’s operation from this area such as current tonnage readings, tonnage alarm 
conditions, reverse load readings, etc.  

 
Block:DB 

DB130 
Data 
Type Bit 

Description

+0.0 INT - SPM Value 
+2.0 INT - Scale Set Value 
+4.0 INT - Ch1 Peak value in Ton (in PEAK or MONITOR Mode) 

Ch1 Calibrate number (in CALIBRATE Mode)   
+6.0 INT - Ch2 Peak value in Ton (in PEAK or MONITOR Mode) 

Ch2 Calibrate number (in CALIBRATE Mode)   
+8.0 INT - Ch1 Trend value in Percent or Ton 
+10.0 INT - Ch2 Trend value in Percent or Ton 
+12.0 INT - Ch1 Sample value in Ton  
+14.0 INT - Ch2 Sample value in Ton 
+16.0 INT - Ch1 Reverse Load in Ton 
+18.0 INT - Ch2 Reverse Load in Ton 
+20.0 
+20.1 
+20.2 
+20.3 
+20.4 
+20.5 
+20.6 
+20.7 
+21.0 
+21.1 
+21.2 
+21.3 
+21.4 
+21.5 
+21.6 
+21.7 

Bit 0 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 

Ch1 High Trend Alarm Indication Bit  
Ch1 Low Trend Alarm Indication Bit 
Ch2 High Trend Alarm Indication Bit 
Ch2 Low Trend Alarm Indication Bit 
Ch1Capacity Alarm Indication Bit 
Ch2 Capacity Alarm Indication Bit 
- 
- 
Ch1 Press Curve Alarm Indication Bit 
Ch2 Press Curve Alarm Indication Bit 
Ch1 High Tracking Alarm Indication Bit 
Ch1 Low Tracking Alarm Indication Bit 
Ch2 High Tracking Alarm Indication Bit 
Ch2 Low Tracking Alarm Indication Bit 
 
 

+22.0 
+22.1 
+23.0 
+23.1 
+23.2 
+23.3 
+23.4 
+23.5 
+23.6 
+23.7 

BIT 
 
 

0 
1 
8 
9 
10 
11 
12 
13 
14 
15 

Ch1 Cal (-)Sign Bit 
Ch2 Cal (-)Sign Bit 
Module In Calibrate Mode Indication Bit 
Module In Peak Mode Indication Bit 
Module In Monitor Mode Indication Bit 
Sampling in progress Indication Bit 
Sample Ready Indication Bit (stay On until the mode changes) 
Alarm Rest in progress bit 
 
Low Alarm Inhibit Bit 

+24.0 INT - Cycle Counter 
+26.0 INT -    Current Module report Angle (in Calibrate mode only) 
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SPM Value 
This reports the current stroke per minute of the press cycle speed. 
 
Scale Set Value 
Reports current scale setting of the module . 
 
Ch1(2) Peak value in Ton /  Calibrate number 
This integer word represents the peak load on channel 1(2) in Peak and Monitor Mode. 
In Calibrate mode, this displays the sensor’s balance reading or calibration(gain) readings. 

 
Ch1(2)Trend Deviation in Percent or Ton 
This integer word represents the difference between current peak load and sample peak load, in 
percentage or tonnage. This value can be used to control Trend deviation LED type display 
(Only valid in Monitor mode). 
 
Ch1(2) Sample value in Ton 
This integer word represents the average of the load values in Tons when learning(sampling) 
cycle is completed in Monitor mode.  

 
Ch2 Reverse Load in Ton 
Integer word represents the peak reverse load value in tons for the current machine cycle. 
 
Capacity Alarm Indication Bit 
When on (1), the current peak tonnage of the channel has met or exceeded the Capacity alarm set 
limit. 

 
High/Low Trend Alarm Indication Bit 
When on (1), the current peak tonnage has met or exceeded the high/low tolerance percentage or 
tonnage setting  from the sample tonnage. 

 
High/Low  Tracking Alarm Indication Bit 
When on (1), the some of the area of current tonnage signature has broken the high/low tolerance 
limit band around the sample tonnage signature within look window. 
 
Press Curve Alarm Indication Bit 
When on (1), the some of the area of current tonnage signature has broken the Press Curve limit 
within look window. 

 
Module In Calibrate Mode Indication Bit  
This bit is reported by the module that it is actually in Calibration mode when On(1). 

 
Module In Peak Mode Indication Bit  
This bit is reported by the module that it is actually in Peak mode when On(1). 
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Module In Monitor Mode Indication Bit  
This bit is reported by the module that it is actually in Monitor mode when On(1). 

 
Sampling in progress Indication Bit  
This bit is reported by the module that it is currently in learning(sampling) mode when On(1). 
 
Sample Ready Indication Bit (stay On until the mode changes) 
This bit is reported by the module that it completed the learning cycle and established new 
sample tonnage when On(1). 

 
Alarm Reset in Progress Bit 
This bit is reported by the module that it is currently resetting all alarm conditions when On(1). 

 
Current Module report Angle (in Calibrate mode only) 
This reports the current crank angle read from Encoder attached to the module. 
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Chapter 4 
 

Initial Hardware Setup Procedures 
 

 A complete listing of a sample Siemen’s ladder logic program is included at the back of 
this manual. Examples shown here are for reference. 

 
 

All values are 0 (default) on initial start-up.  This means that all alarms are 
disabled.  You must make the following adjustments for proper operation: 

      

 set station number 

 set hi/low 

 set scale value 

 set auto zero (az) control 

 set channel 1 calibration 

 set channel 2 calibration 

 set encoder angle position 

 set master/slave mode 
 
 
 

Menu Sequence: 

Sequence numbers 1-8 are for on-line settings 
Sequence numbers 1-12 are for off-line settings 

 
1. ch1 cal (default on power-up) 
2. ch2 cal 
3. set encoder angle  
4. station 
5. hi / lo 
6. scale 
7. az 
8. module mode 
9. a/d zero value (factory setting only) 
10. a/d zero set (factory setting only) 
11. master/slave mode setting* 
12. aux/cam input check (not used) (factory check only) 
 
*  master/slave mode setting is required for proper operation. 
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Initial Setup Procedures: 

Step 1.  Set the Station Number 

 
 From the HM-2-SSI module, press SELECT until “station” scrolls across the display. From 

this menu you can change the station number by pressing the up/down buttons to coordinate 
with the Profibus communications. 

 

Step 2. Set the Hi/Low Gain Range 

 Press SELECT until “hi/low” scrolls across the display.  Change the module’s hi/low alarm 
settings from here. 

 LOW = 140k CAL resistor range. 
 HI = 1M CAL resistor range. 
 

Step 3. Set the Scale Value 

 Press SELECT until “scale” scrolls across the display.  Use the up/down buttons to set the 
scale value to coordinate with the tonnage of the press the module is communicating with. 

 

Step 4. Auto-Zero (AZ) Control 

 Press SELECT until “az” scrolls across the display.  The auto-zero value is normally set to 
‘on’.  Set to ‘off’ only on special circumstances. 

 

Step 5. Click on Calibration Mode 

 Using the software operator interface, click on Calibration Mode to put the HM-2-SSI 
module into Cal Mode so calibration can be completed. 

 

Step 6. Confirm that Profibus Communications are Online (Solid Green Status LED) 

 Using the software operator interface, click on Calibration Mode to put the HM-2-SSI 
module into Cal Mode so calibration can be completed. 

 

Step 7. Calibrate Channel 1 

 Press SELECT until “ch1 cal” scrolls across the display.  Under this menu, users can change 
three values: balance value, calibration value, and az value. 

 

 Balance Mode → using the balance potentiometer, you can manually adjust the balance 
to zero. 

 
 Calibration Mode → using the gain potentiometer, a user can manually adjust the setting 

to their desired calibration number. 
 

 Auto-Zero Mode → when AZ is turned on, this Mode will automatically zero this value. 
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Step 8. Calibrate Channel 2 

 
 Repeat Step 6 using ‘ch2 cal’. 
 
Step 9.  Set Encoder angle position 

 
Move silde position to Top where reads “0” degree for crank angle. 
Use “DOWN” button to clear any angle offset previsouly stored in the module. 
Use “UP” button to zero the angle position. 
Push “SAVE” button to save current offset. 
 
 

Step 10. Set master/slave mode  
 
       Use “DOWN” button to set module for master mode. 
       Use “UP” button to set module for slave mode. 
       Push “SAVE” button to save current mode setting.  
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Install GSD File Procedures 
 

Step 1. Begin by opening up SIMATIC Manager. 
 

Step 2. In SIMATIC Manager, click File → New. 
 

Step 3. Type gsdinstall for the project name, and click OK. 
 

Step 4. From the menu toolbar, click Insert → Station → SIMATIC 300 Station. 
 

Step 5. Double click SIMATIC 300  → Hardware. 
 

Step 6. From the menu toolbar, click Options → Install GSD File. 
 

Step 7. Browse to locate the .gsd file, and click install, then OK, and then Close. 
 Can be located on the installation CD provided by Helm 

 
Step 8. Keep SIMATIC Manager open, but close the current gsdinstall project. 
 
 

 
 

Install Siemen’s Ladder Logic Procedures 
 

Step 1. In SIMATIC Manager, click File → Retrieve → Select File → Open. 
 

Step 2. Accept the default directory, and click OK. 
 

Step 3. Click OK, then click OK to the next dialog that appears as well. 
 

Step 4. Double click SIMATIC 300 Station → Hardware. 
 
Step 5. From here, you are able to view/edit the hardware configurations of the card, by 

double clicking the card’s bitmap. 
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Add a New Module 
 
Step 1. In SIMATIC Manager, click File → Open → [saved application] 
 
Step 2. Double click the Simatic X00 Station 

 X is the version number of the station that you are using 
 

Step 3. From this screen, click on PROFIBUS DP master system 
 The bottom part of your screen should say PROFIBUS DP master system 
 If you do not click on this first, you will not be able to continue to add a new 

module. 
 

Step 4. Now from the toolbar, click Insert → Insert Object 
 
Step 5. From the pop-up, click Additional Field Devices → General → SGI 2 Channel 

 If done properly, the properties window will appear. 
 
Step 6. Document the Address that is displayed in the textbox. 

  Notice that the address provided is incremented from the address of the 
previous module.  This is done to avoid two modules obtaining the same 
address. 

 This address number is actually the station number of the module. 
 

Step 7. Click OK 
 

Step 8. Click the new module, and document the I Address (PIW Address), as well as the 
Q Address (PQW Address) that can be found in the bottom display box. 

 
Step 9. Create a database for the new module by opening and existing database and 

saving it as “DB(Address)”. 
 Example: Address = 4, so the database name is DB4 

 
Step 10. Now open OB1 from your application 
 
Step 11. In FC25 change: 

 PIW address to the PIW address that was documented from step 8 
 DB_ Num to the address that you documented from step 6 

 
Step 12. In FC26 change: 

 PQW address to the PQW address that was documented from step 8 
 DB_ Num to the address that you documented from step 6 
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Chapter 5 
 
 

System Troubleshooting Guide 
 

 
 

HT-400 Sensor Ohm Readings 
 

Green-Black…………………………  350 ohms 
Red-White…………………………...  350 ohms 
All other color combinations…..……  266 ohms 
All colors to Ground...………………  open 
Shield to Ground.……………………  open 
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Appendix A: Specifications: 
 

Electrical Specifications: 
 

Power Consumption 146 MA at 24 vdc 

Number of Channels 2 (isolated) 

A/D Conversion Method 12 bit 

Normal Mode Rejection 
     (between + input and - 
input) 

50 db at 2000 gain 

AMP roll-off frequency 650 Hz at 3000 Gain  

Calibration Software Selectable 

Physical Specifications: 
 

Press Buttons 4 buttons for menu navigation and selection 

LED Indicators 3 LEDs for Calibration, Auto-Zero, and Status 

Recommended Cable Strain Gage Cable (Helm part number 6117) 

Terminal Strip 8-pin removable 

Environmental Specifications: 
 

Operating Temperature 0°C to 60°C (32°F to 140°F) 

Hazardous Environment 
Classification 

Class 1 Division 2 Hazardous Environment 

Input Specifications: 
 

Type of Input Strain Gage (350 ohm, 700 ohm) 

Input Impedance 1K 

Display Resolution Up to 0.1% of full scale 

Overall Module Accuracy 1% of full scale 

Module Update Time 100 µsec 
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 Appendix B: Module Diagrams: 

HM2-SSI Load Module 
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Profibus Field Wiring Diagram 
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I/O Wiring Connection 
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Appendix C: GSD File: 
 
;-----------------------------------------------------------------------------; 
; GSD Multifunktionales Leistugsmessgeraet PROFIBUS DP                        ; 
; Fa. GOSSEN-METRAWATT GMBH Thomas-Mann-Str. 16 - 20, D-90471 Nuernberg       ; 
; Tel.: 0911/8602-0                                                           ; 
; Stand: 21.09.99                                                             ; 
;-----------------------------------------------------------------------------; 
#Profibus_DP 
GSD_Revision=2 
Vendor_Name         = "HELM INSTRUMENT"     ; Herstellername 
Model_Name          = "SGI 2 CHANNEL  thru stroke"              ; 
Herstellerbezeichnung 
Revision            = "1.0"                       ; Ausgabestand des Geraets 
Ident_Number        = 0x1235                      ; Ident-Nummer 
Protocol_Ident      = 0                           ; PROFIBUS_DP Protokoll 
Station_Type        = 0                           ; Slave-Station 
Hardware_Release    = "02"                        ; Hardware-Stand 
Software_Release    = "V3.00"                     ; Software-Stand 
9.6_supp            = 1                           ; Baudrate 9.6kB unterstuetzt 
19.2_supp           = 1                           ; Baudrate 19.2kB unterstuetzt 
93.75_supp          = 1                           ; Baudrate 93.75kB unterstuetzt 
187.5_supp          = 1                           ; Baudrate 187.5kB unterstuetzt 
500_supp            = 1                           ; Baudrate 500kB unterstuetzt 
1.5M_supp           = 1                           ; Baudrate 1.5MB unterstuetzt 
3M_supp             = 1                           ; Baudrate 3MB unterstuetzt 
6M_supp             = 1                           ; Baudrate 6MB unterstuetzt 
12M_supp            = 1                           ; Baudrate 12MB unterstuetzt 
MaxTsdr_9.6         = 60 
MaxTsdr_19.2        = 60 
MaxTsdr_93.75       = 60 
MaxTsdr_187.5       = 60 
MaxTsdr_500         = 100 
MaxTsdr_1.5M        = 150 
MaxTsdr_3M          = 250 
MaxTsdr_6M          = 450 
MaxTsdr_12M         = 800 
Bitmap_Device       = "Helmn" 
Implementation_Type = "SPC3"                      ; ASIC SPC3 wird verwendet 
;----Slave spezifische Werte----- 
;OrderNumber="A2000 L2" 
Freeze_Mode_supp    = 0                           ; kein Freeze Mode 
Sync_Mode_supp      = 0                           ; kein Sync Mode 
Auto_Baud_supp      = 1                           ; automatische Baudratenerk. 
Set_Slave_Add_supp  = 0                           ; Adressierung ueber BUS 
Min_Slave_Intervall = 1                           ; min. Slave-Aufrufzeit 
Modular_Station     = 0                           ; Produktbeschreibung 0=Kompaktger?, 
1=Modular 
Max_Diag_Data_Len   = 6                           ; keine User Diagnosen 
; 
; 
Module= "96Words In, 64Words Out" 0x7f,0x7f,0x7f,0x7f,0x5f,0x5f 
EndModule 
;Slave_Family=3 
Slave_Family=0 
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Appendix D: Address Values: 
 

Input Image Block: DB130(Ch1,2)  DB136(Ch3,4) 
Block:DB 

DB130 
Data 
Type Bit 

Description

+0.0 INT - SPM Value 
+2.0 INT - Scale 
+4.0 INT - Ch1 Peak value in Ton (in PEAK or MONITOR Mode) 

Ch1 Calibrate number (in CALIBRATE Mode)   
+6.0 INT - Ch2 Peak value in Ton (in PEAK or MONITOR Mode) 

Ch2 Calibrate number (in CALIBRATE Mode)   
+8.0 INT - Ch1 Trend value in Percent or Ton 
+10.0 INT - Ch2 Trend value in Percent or Ton 
+12.0 INT - Ch1 Sample value in Ton  
+14.0 INT - Ch2 Sample value in Ton 
+16.0 INT - Ch1 Reverse Load in Ton 
+18.0 INT - Ch2 Reverse Load in Ton 
+20.0 
+20.1 
+20.2 
+20.3 
+20.4 
+20.5 
+20.6 
+20.7 
+21.0 
+21.1 
+21.2 
+21.3 
+21.4 
+21.5 
+21.6 
+21.7 

Bit 0 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 

Ch1 High Trend Alarm Indication Bit  
Ch1 Low Trend Alarm Indication Bit 
Ch2 High Trend Alarm Indication Bit 
Ch2 Low Trend Alarm Indication Bit 
Ch1Capacity Alarm Indication Bit 
Ch2 Capacity Alarm Indication Bit 
- 
- 
Ch1 Press Curve Alarm Indication Bit 
Ch2 Press Curve Alarm Indication Bit 
Ch1 High Tracking Alarm Indication Bit 
Ch1 Low Tracking Alarm Indication Bit 
Ch2 High Tracking Alarm Indication Bit 
Ch2 Low Tracking Alarm Indication Bit 
 
 

+22.0 
+22.1 
+23.0 
+23.1 
+23.2 
+23.3 
+23.4 
+23.5 
+23.6 
+23.7 

BIT 
 
 

0 
1 
8 
9 
10 
11 
12 
13 
14 
15 

Ch1 Cal (-)Sign Bit 
Ch2 Cal (-)Sign Bit 
Module In Calibrate Mode Indication Bit 
Module In Peak Mode Indication Bit 
Module In Monitor Mode Indication Bit 
Sampling in progress Indication Bit 
Sample Ready Indication Bit (stay On until the mode changes) 
Alarm Rest in progress bit 
 
Low Alarm Inhibit Bit 

+24.0 INT - Cycle Counter 
+26.0 INT -    Current Module report Angle (in Calibrate mode only) 
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Output Image Block: DB131(Ch1,2)  DB137(Ch3,4) 
 

Block:DB
DB131 

Data 
Type Bit 

Description 

+0.0 
+0.1 
+0.0 
+1.0 
+1.1 
+1.2 
+1.3 

Bit 
Bit 
Bit 
Bit 
Bit 
Bit 
Bit 

0 
1 
2 
8 
9 
10 
11 

 
Alarm Reset 
 
Set Calibrate mode 
Set Setup mode 
Set Monitor Mode 

+2.0 INT - Look Window Start Degree  (in Calibrate mode only) 
+4.0 INT - Look Window Degree Increment (1, 2, 4, 6, 8, 10,) (in Calibrate mode Only) 
+6.0 INT - Set Ch1 High Capacity Alarm Value (in Calibrate mode) 
+8.0 INT - Set Ch2 High Capacity Alarm Value (in Calibrate mode) 
+10.0 
+11.0 
+11.1 
+11.2 
+11.3 
+11.4 
+11.5 
+11.6 
+11.7 

- 
Bit 
Bit 
Bit 
Bit 
Bit 
Bit 
Bit 

- 
0 
1 
2 
3 
4 
5 
6 
7 

- 
Press Curve Alarm On/Off 
Tracking Alarm On/Off 
Trend Alarm On/Off 
Delta Track On/Off 
Alarm Value type   (1 = Tolerance in Ton,  0 =  Tolerance in Percent) 
AMPTRACK On/Off 
 
8000 DP On/Off 

+12.0 INT - Set Sample Count (2, 4, 8, or 16) 
+14.0 INT - Set Low Alarm Inhibit Count 
+16.0 INT - Alarm Start Degree Value (Tracking alarm only) 
+18.0 INT - Alarm Stop Degree Value (Tracking alarm only) 
+20.0 INT  Set Ch1 Low Tolerance value 
+22.0 INT - Set Ch1 High Tolerance value 
+24.0 INT  Set Ch2 Low Tolerance value 
+26.0 INT - Set Ch2 High Tolerance value 
+28.0 INT - Set Threshold for Tracking Alarm (In Percent) 
+30.0 INT - Press Curve Input Value  in 0 degree (in Calibrate mode) 
+32.0 INT - Press Curve Input Value in 10 degree (in Calibrate mode) 
+x.0 INT - Press Curve Input Data  in y degree (in Calibrate mode) 
+98.0 INT - Press Curve Input Value in 340 degree (in Calibrate mode) 
+100.0 INT - Press Curve Input Value in 350 degree (in Calibrate mode) 
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  Signature Data Block: DB126(Ch1,2)  DB133(Ch3,4) 
 

BLOCK 
DB 
DB126 

Data 
Type 

Bi
t 

Description 

+0.0 INT - Ch1 Wave Data - Index 1 
+2.0 INT - Ch1 Wave Data - Index 2 
+4.0 INT - Ch1 Wave Data - Index 3 
+x.0 INT - Ch1 Wave Data - Index n    (n = 1 - 224)   (x = n * 2 + 4) 
+444.0 INT - Ch1 Wave Data - Index 223 
+446.0 INT - Ch1 Wave Data - Index 224 
+448.0 INT - Ch2 Wave Data - Index 1 
+450.0 INT - Ch2 Wave Data - Index 2 
+452.0 INT - Ch2 Wave Data - Index 3 
+x.0 INT - Ch2 Wave Data - Index n    (n = 1 - 224)  (x = n * 2 + 452) 
+892.0 INT - Ch2 Wave Data - Index 223 
+894.0 INT - Ch2 Wave Data - Index 224 
+896.0 INT - Cycle Counter 
+898.0 INT -    Ch1 High AD 
+900.0 INT - Ch1 Peak Value in Ton  
+902.0 INT - Ch1 Low AD 
+904.0 INT - Ch1 Alarm Angle 
+906.0 INT - Ch1 Alarm Value in Ton at the Angle 
+908.0 INT -    Ch2 High AD 
+910.0 INT - Ch2 Peak Value in Ton  
+912.0 INT - Ch2 Low AD 
+914.0 INT - Ch2 Alarm Angle 
+916.0 INT - Ch2 Alarm Value in Ton at the Angle 
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  Common Control Data Block: DB126(Ch1,2)  DB133(Ch3,4) 
 

Block:D
B 
DB140 

Data 
Type Bi

t 

Description 

+0.0 INT 0 
1 
2 

Set All Module to Calibrate Mode 
Set All Module to Setup Mode 
Set All Module to Monitor Parts Mode 

+2.0 INT - Alarm Reset ( 0 = Normal. 1 = Reset ) 
+4.0 INT - 

0 
1 
2 
3 

Wave Xfer Bits 
Current Wave Xfer Bit 
Sample Wave Xfer Bit 
Pcurve Xfer Enable Bit 
Quick Data Xfer Enable Bit 

+6.0 INT -  
+8.0 INT - Current Mode Report from Module (1 = Cal, 2 = Setup, 4 = Monitor) 
+10.0 INT - Current Encorder Angle 
+12.0 INT   
+14.0 INT   
+16.0 INT   
+18.0 INT - External Software Status 

 0 
 

RSTMon Software Heartbeat  (toggle between 1 and 0 every 3 seconds  
when the software is running)

+20.0 INT - Cycle Counter 
+22.0 
 

INT - 
0 
1 
2 
3 
4 
5 
6 
7 
8 

ADC Command Bits (Used by RSTMon4C) 
ADC Job Download Bit 
Change Mode to Monitor Parts Bit 
Change Mode to Setup Bit 
 
 
 
 
 
ADC Command Complete Bit (Used by RSTMon4C) 

+24.0 INT - ADC Job number (Used by RSTMon4C) 
+26.0 INT - SAMPLING IN PROGRESS BITS 

 0 
1 
2 
3 
4 
5   

Module 1 in Sampling Indication Bit 
Module 2 in Sampling Indication Bit 
Module 3 in Sampling Indication Bit 
Module 4 in Sampling Indication Bit 
Module 5 in Sampling Indication Bit 
Module 6 in Sampling Indication Bit 
 

+28.0 INT - SAMPLE READY BITS (bits stays on until the mode change to setup or 
cal) 

 0 
1 
2 
3 
4 
5 
 

Sample Ready for Module 1 Indication Bit 
Sample Ready for Module 2 Indication Bit 
Sample Ready for Module 3 Indication Bit 
Sample Ready for Module 4 Indication Bit 
Sample Ready for Module 5 Indication Bit 
Sample Ready for Module 6 Indication Bit 
 

+30.0 INT - TONNAGE MODULE 1 ALARM BITS 
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 0 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 

Ch1 High Trend Alarm Bit for Module 1 Indication Bit 
Ch1 Low Trend Alarm Bit for Module 1 Indication Bit 
Ch2 High Trend Alarm Bit for Module 1 Indication Bit 
Ch2 Low Trend Alarm Bit for Module 1 Indication Bit 
Ch1 Capacity Alarm Bit for Module 1 Indication Bit 
Ch2 Capacity Alarm Bit for Module 1 Indication Bit 
- 
- 
*Ch1 High Tracking Alarm Bit for Module 1 Indication Bit 
*Ch1 Low Tracking Alarm Bit for Module 1 Indication Bit 
*Ch2 High Tracking Alarm Bit for Module 1 Indication Bit 
*Ch2 Low Tracking Alarm Bit for Module 1 Indication Bit 
*Ch1 Press Curve Alarm Bit for Module 1 Indication Bit 
*Ch2 Press Curve Alarm Bit for Module 1 Indication Bit 
 

+32.0 INT - TONNAGE MODULE 2 ALARM BITS   (use index [15] for bit 
description) 

+34.0 INT - TONNAGE MODULE 3 ALARM BITS   (use index [15] for bit 
description) 

+36.0 INT - TONNAGE MODULE 4 ALARM BITS   (use index [15] for bit 
description) 

+38.0  INT  -  
+40.0 INT -  
+42.0 INT -  
+44.0 INT -  
+46.0 INT -  
+48.0 INT -  
+50.0 INT -  
+52.0 INT -  
+54.0 INT - Ch1 Peak tonnage  value for Module 1 
+56.0 INT - Ch2 Peak tonnage  value for Module 1 
+58.0 INT - Ch1 Peak tonnage  value for Module 2 
+60.0 INT - Ch3 Peak tonnage  value for Module 2 
+62.0 INT - Ch1 Peak tonnage  value for Module 3 
+64.0 INT - Ch2 Peak tonnage  value for Module 3 
+66.0 INT - Ch1 Peak tonnage  value for Module 4 
+68.0 INT - Ch2 Peak tonnage  value for Module 4 
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